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I/ Présentation du projet Nano-satellite étudiant : 

1) Description du projet Nano-satellite 

 Ce projet a été proposé dans le cadre du LabEx UnivEarths, et est soutenu par le CNES 

(Centre National d’Etudes Spatiales). Le projet a pour objectif de faire réaliser par des 

étudiants en provenance de différentes formations un satellite en 5 ans. Celui-ci se place dans 

la ligne des Cubesat et a pour but de faire de la science et de développer des compétences 

spatiales concrètes à des étudiants de tous niveaux qui sont encore en formation. 

Les objectifs scientifiques sont les suivants: 

 

- La mesure du rayonnement gamma et du contenu électronique total (TEC) dans les cornets 

Polaires et dans l'Anomalie de l'Atlantique Sud (AAS) 

 

- Le test d'un nouveau type de détecteur gamma 

 

- La mesure du TEC par un GPS bi-fréquence 

 

La plateforme du satellite est composée de 3 unités de 10x10x30cm
3
 : 2 unités sont 

nécessaires à la plateforme et au scintillateur, la 3
ème

 au GPS. De plus, des contraintes 

spécifiques aux Cubesat, tels que le poids ou la puissance de fonctionnement, devront être 

prises en compte durant l'étude. Comme nous l'avons dit précédemment, l'objectif durant ce 

stage est d'effectuer une analyse globale de la mission avant de voir les possibilités de 

réalisation.  Pour cela, il va falloir nous appuyer sur les expertises scientifiques et techniques 

des professionnels de ce secteur, comme par exemple les ingénieurs du CNES. 

Ce projet s'exécute en collaboration avec différentes formations de l’Université, sous la tutelle 

d’Hubert Halloin (APC, Université Denis Diderot) et de Philippe Lognonne (Institut de 

Physique du Globe de Paris) : 

_ Des étudiants du Master 2 OSAE (Outils et Systèmes de l'Astronomie et de l'Espace), 

_ Des étudiants des UFR de physique et STEP de l'université Denis Diderot (Licence, Master 

et Magistère), 

_ Des étudiants de l'école d'ingénieur de Denis Diderot (EIDD). 

 

La première étape a été de déterminer les groupes de travail en fonction des différents sous-

systèmes, exposées dans ce qui suit. 

 

2) Analyse système de la mission 

 

Selon le planning prévisionnel, l'équipe a identifié les différents sous-systèmes et en faire un 

dimensionnement préliminaire. Les sous-systèmes identifiés jusqu'a maintenant sont : 

- Gestion de projet/Ingénierie système 

- Communication 

- Dimensionnement de la charge utile 

- Plateforme CubeSat 

- Analyse mission 

- Télécommunications 

- Architecture mécanique 

- Architecture électrique 
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- Architecture informatique 

 

3) Orbitographie 

 

Le choix de l'orbite doit répondre aux besoins scientifiques de la mission, mais doit également 

être en phase avec les spécifications techniques. Le projet étant en phase de dimensionnement 

préliminaire, on va s'attacher dans cette partie à proposer l'étude d'orbites correspondantes à 

ce que nous avons déjà en main. Ceci au moyen du logiciel STK (System Tool Kit). Cela se 

révèlera utile par la suite afin de réaliser des scénarios de dimensionnement du satellite, par 

simulation. Le type d’orbite choisi dans ce projet est de type circulaire avec une inclinaison de 

97 degrés et une altitude de 650 km. Nous avons fait le choix d’une altitude de 650km afin 

que le satellite après son fonctionnement retombe sur terre. Quant à l’inclinaison, celle-ci 

s’élève à 97 degrés, ce qui correspond à l’inclinaison des orbites héliosynchrones. Ces 

derniers sont très utilisés par les satellites car l’angle entre le soleil et le plan de l’orbite est 

constant.  

 

4) Description du Nano-satellite  

 

Les nanosatellites entrent dans la catégorie des "petits" satellites. En effet, leurs dimensions 

typiques sont de 10 × 10 × 10 cm
3
 pour environ 1 kg. Malgré tout, cela reste un satellite et, 

comme tout satellite, sa mise en orbite nécessite avant tout un travail d’ingénierie avancée 

passant par des phases de définition, d’intégration et de validation. Un tel travail s’étale sur 

plusieurs années, même pour ces petites structures. 

Le projet auquel nous participons actuellement est un projet étudiant de nanosatellite étudiant 

de type CubeSat, lancé cette année par l’Université Paris Diderot, sous l’impulsion du Labex 

(Laboratoire d’excellence) UnivEarthS. De tels projets existent depuis le début des années 

2000 et consistent à fournir aux étudiants des Universités engagés dans ces projets tout un 

ensemble d’éléments standardisés et validés (pour la plupart) pour le spatial. Ceci afin que les 

étudiants puissent s’organiser eux-mêmes autour d’un véritable projet d’ingénierie. Ainsi, le 

succès de ce type de projet ne réside pas tant dans la réussite scientifique de la mission, mais 

plutôt dans l’apport pédagogique qu’aura apporté le développement du satellite aux étudiants. 

 

Le satellite comportera donc deux charges utiles exécutant des mesures différentes. 

– Une première charge utile, proposée par l’APC, consiste à mesurer le spectre des électrons 

et des photons gammas dans les cornets polaires et au niveau de l’Anomalie Sud-Atlantique 

(SAA). Cette mesure serait utile scientifiquement afin de compléter les données existantes et 

d’affiner notre connaissance de la magnétosphère. 

– La seconde charge utile, proposée par l’IPGP, consiste à mesurer le contenu électronique 

total, ou Total Electron Content (TEC) de l’ionosphère dans ces mêmes zones. 

 

5) Objectifs pédagogiques 

 

Le principal objectif du projet est d’apporter aux étudiants s’impliquant dans sa réalisation 

une expérience de l’approche "système". Ces derniers sont en effet au coeur du projet et 

doivent s’organiser afin de le mener à bien. Ainsi, chaque étudiant s’intègre dans une équipe 

de travail chargée d’un aspect spécifique du projet. 

Les étudiants peuvent donc mettre en pratique toutes les connaissances théoriques qu’ils ont 

pu acquérir au cours de leur formation, et continuer d’apprendre auprès d’experts et de 
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collaborateurs impliqués dans le projet. Ces derniers travaillent notamment dans les 

laboratoires impliqués et au CNES (Centre National d’Etudes Spatiales). 

Le projet s’étalant sur 5 ans, plusieurs générations d’étudiants se succéderont. Il est donc 

important de laisser une trace écrite et organisée du travail accompli, afin que les étudiants 

suivants puissent continuer sans avoir à recommencer. 

 

Pour ma part, ma place dans le projet se situe dans la phase de predimensionnement du nano-

satellite, notamment la réalisation de scénario d’orbite du satellite. Dans un premier temps, 

mon objectif sera d’évaluer le débit d’information émis par le satellite et reçu par la station 

sol, ainsi que  de calculer grâce au logiciel STK  la puissance instantanée reçu par les 

panneaux solaires. Dans un second temps, mon travail consistera en l’interprétation des 

résultats. Enfin, ma mission consiste également en la mise ne place d’un tutoriel STK adapté 

au projet nanosatellite (cf annexe).  

 

 

 

II\ STK : Un logiciel de dimensionnement   

1) Présentation du logiciel 

 

 STK « Systems Tool Kit », développé par AGI, est une suite logicielle dédiée à la simulation 

de systèmes spatiaux et aéronautiques. 

Ce logiciel sur étagère, est utilisé par les grands industriels mondiaux notamment du monde 

militaire depuis 1989. Les grands industriels français dont Alcatel Alenia Space, Astrium 

SAS, CNES, EADS, ESA, MBDA, Thalès l’utilisent actuellement comme l’Armée Française 

(Ministère de la Défense, DGA…). 

 Les fonctionnalités couvertes par la suite STK sont les suivantes : 

 

-modélisation de scénarios comprenant des satellites, avions/drones, missiles, véhicules 

terrestres, stations terrestres, zones d'intérêt, senseurs pour modélisation d'instruments, 

planètes, étoiles, terre, modèles numériques de terrain… 

-modules supplémentaires tels que : visualisation 3D, analyse statistique de couverture et de 

solution de navigation/localisation par satellite, modélisation de systèmes de 

radiocommunication, modélisation de systèmes de détection radar, prise en compte de MNT, 

analyse des risques de collision, restitution d'orbites à partir de mesures… 
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2) Création d’un scénario sur STK  

 

Dans notre cas la création d’un scénario concernant un satellite en orbite autour de la 

Terre nous intéresse particulièrement. De ce fait, dans un premier temps nous allons 

réaliser un scénario ‘Test’ comprenant un satellite ayant des panneaux solaires  en 

orbite circulaire à une altitude de 650 km. Nous allons également installer une station 

sol à Paris comprenant une antenne et un récepteur permettant la transmission et la 

réception de données par le satellite. Nous allons également associer une antenne au 

satellite qui servira à la transmission de données à la station sol.  

Dans un second temps, une fois le scénario réalisé, nous allons calculer plusieurs 

paramètres tels que la puissance instantanée reçue par les panneaux solaires, ainsi que 

la surface couverte par le satellite quand celui-ci est détecté par la station sol. 

Concernant le satellite, mon choix s’est porté sur le modèle Helios2A comportant des 

panneaux solaires. 

 

 

 
 

 

Nous obtenons le scénario suivant après avoir effectué toute les étapes intermédiaires : 
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A présent afin de vérifier que ce scénario ‘Test’ fonctionne correctement, nous allons calculer 

la puissance instantanée reçu par les panneaux solaires du satellite. Pour cela  STK utilise la 

formule suivante : 

  
La formule du flux est la suivante :  

 

Fth : facteur thermique  

  

Avec  C0, C1, C2, C3, C4 des constantes thermiques, r : la distance entre le soleil et les 

panneaux solaires  

D: facteur de dégradation 

 CE%: efficacité de la cellule solaire  

 AE%: la surface des panneaux solaires qui sont en contact avec les rayons du soleil  
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ISL: correspond à l’angle entre le soleil et le vecteur normal aux panneaux solaires.  

 

Après avoir compris la formule, nous avons demandé au logiciel STK de tracer le graphique 

de la puissance reçu par les panneaux solaires en Watt en fonction du temps. Nous obtenons le 

graphique suivant : 

 

Nous pouvons observer d’après ce graphique que les panneaux solaires reçoivent une 

puissance maximal d’une valeur de 60 000 mw à des heures bien précises comme par exemple 

à 10h,16h,18h etc. Nous pouvons déduire de ces observations que les panneaux solaires sont 

complètement exposés au soleil c’est pour cette raison que nous avons un maximum de 

puissance reçue par la surface des panneaux. En dehors de ces heures, la puissance est nulle 

ce qui montre que les panneaux ne sont pas éclairés et par conséquent que le satellite se trouve 

dans une zone d’ombre.  

Nous  pouvons également construire un graphique correspondant à la zone de couverture du 

satellite lorsque celui est détecté par la station sol. Cela nous permet de déterminer à quel 

moment le satellite communique avec la station sol et par conséquent d’évaluer le débit 

d’information circulant entre les deux objets. Le graphique est le suivant : 
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 Après avoir effectué ce scénario ‘Test’, nous allons à présent réaliser le scénario lié au projet 

nano satellite.  

 

III/ Scénario Final 

1) Conception du scénario  

Pour réaliser ce scénario, nous avons dû dans un premier temps nous documenter sur les 

caractéristiques liées au satellite ainsi qu’aux propriétés de la station sol, notamment le 

récepteur, l’antenne. Pour cela, je me suis basé sur le projet Swisscube qui est un projet de 

cubesat étudiant réalisé par l’Ecole Polytechnique Fédérale de Lausanne. Les rapports mis en 

ligne m’ont permis de réunir toute les informations nécessaires à la réalisation d’un scénario 

cohérent.  

Dans un premier temps mon objectif a été de construire un cubesat 3u ayant les 

caractéristiques liés au projet notamment :  

Type de satellite  Cubesat 3u  

Masse  4 kg  

Dimensions ( 3cm ) 10*10*30 

Orbite  Circulaire, inclinaison 97°  

Type d’Antenne  lié au satellite  Dipôle  

Pointage  Terre  

Altitude  650 km  

 

 

Ce type de satellite n’existant pas dans la base de donnés du logiciel STK, nous avons du en 

construire un, grâce au logiciel Sketchup  que nous avons importé par la suite sur STK.  
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Ce cubesat 3u est la superposition de 3 cubesats 1u dans lequel nous avons supprimé les 

panneaux solaires au niveau de la jonction pour éviter les erreurs  lors du calcul de la 

puissance reçue par les panneaux solaires. 

Après avoir crée ce satellite, nous avons installé une antenne sur celui-ci qui permettra par la 

suite la transmission de données à la station sol. Les paramètres de l’antenne sont les 

suivants : 

Type  d’antenne  Dipôle  

 liaison descendante  437.5 Mhz 

Taille  51.4 cm  

Efficacité  100% 

Wave Lenght Ratio  0.249977 

Azimut 0 deg  

Elévation  90 deg  

     

A présent, nous avons crée une station sol se situant à Paris. A cette station nous lui avons 

associée une antenne qui va permettre de transmettre des commandes au satellite, ainsi qu’un 
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récepteur qui aura pour rôle de capter toutes les informations transmises par le satellite.  Cette 

antenne et ce récepteur doivent  posséder des paramètres en adéquation avec l’antenne 

installée sur le satellite pour optimiser la transmission de données et minimiser les pertes 

d’informations. Les paramètres de la station sol sont les suivants : 

Type d’antenne  Dipôles  

Fréquence 145.8 Mhz 

Lieu  Paris, APC  

Efficacité  100% 

Wave Lenght Ratio 0.0483668 

azimut 0 deg 

Elévation 90 deg 

Taille 1 m 

 

 

 

 

 

Type  de récepteur  Simple  

Liaison descendante  437.5 Mhz  

G/T 17.26 dB/K 

Polarisation  Circulaire  

Modulation  BPSK  

Largeur de la bande passante  0.01 Mhz  

 G/T correspond au bruit de récepteur  

 

Nous avons choisi un récepteur ayant une polarisation circulaire afin que celui-ci réceptionne 

l’onde peu importe la direction. 

La modulation BPSK, est une modulation de phase à deux états de la fréquence intermédiaire. 

Cette modulation permet d’obtenir un signal modulé avec deux états de phase 0 et pi, donc ce 

qui réduit l’utilisation de bande passante b pour envoyer un message similaire.  

Nous avons deux bandes radio amateurs: la première une bande à « 2 mètres » à 145 Mhz en 

liaison montante et la bande à « 70 cm » à 437 Mhz en liaison descendante utilisées par les 

nanosatellites. En effet, il est interdit d’émettre dans une gamme de fréquence plus élevée car 

cela est dédié à des satellites de télécommunication commerciaux. 
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Nous avons choisi une fréquence descendante de 437.5 Mhz pour le satellite car la quantité 

d’information descendante soit le débit est plus important c’est pour cela que nous avons pris 

une fréquence plus importante.  

Concernant le type d’antenne aussi bien au niveau du satellite que dans la station sol, notre 

choix s’est porté sur une antenne dipôle car celle-ci est la plus utilisé pour ce genre de 

satellite, elle est également la plus appropriée pour les VHF et UHF.  

Après avoir déterminé tous les paramètres de notre scénario, nous avons réalisé ce modèle sur 

STK.  

 

 

 
 

 

 

Dans la photo suivante, on peut observer la détection du satellite par la station sol : 
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2) Résultats et interprétations  

Après s’être assuré que notre scénario fonctionne correctement, nous allons calculer quelque 

grandeur pour vérifier que notre satellite renvoi des données cohérentes avec la réalité.  

Dans un premier temps, nous allons calculer la puissance instantanée reçue par les panneaux 

solaires du satellite de la même manière que précédemment.  Dans notre cas, il y a 

uniquement le panneau solaire qui pointe en direction du soleil se trouvant dans la face 

supérieur du satellite qui est fonctionnel cela est du à un problème lors de la conception du 

satellite, le logiciel STK ne parvient pas à détecter tous les panneaux. Nous n’avons pas pu 

résoudre ce problème. C’est pour cela que nous allons considérer uniquement un panneau. Le 

graphique de puissance obtenue est le suivant :  

 

 

 

Ce graphique montre  que le panneau solaire est complètement éclairé à certaine heures et 

donc que la puissance reçue est maximale pour une valeur de 1.6 W. On peut également 

observer que cette puissance reste globalement constante pendant cette période mais il existe 

de légères fluctuations qui sont certainement dues à l’albédo de la Terre ou encore à la 

méthode de calcul par tirage de Monte-Carlo mais cette hypothèse n’a pas été vérifié par 

manque de temps.  
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Pour vérifier que ce graphique est cohérent, nous allons calculer la période d’éclairement des 

panneaux solaires à l’aide de la troisième loi de Kepler de façon théorique et nous allons 

comparer la valeur obtenue à la valeur présente dans le graphique.  

D’après la loi de Kepler : 

 

T : Période du satellite  

m : masse du satellite : 10kg 

G : constante e gravitation universelle  6.67* 1110  ui  

M : Masse de la Terre : 6.0* 2410   kg  

a: correspond au rayon de l’orbite : rayon de la Terre  + altitude du satellite 

      

)246(*)1167.6/()37028(4 322 eeeT   

Dans ce calcul nous avons négligé à masse du satellite car celle-ci est très inferieur à la masse 

de la Terre. 

 Après calcul, on obtient une période T=5851s =1h30minute, ce qui est en accord avec le 

graphique, donc le calcul de la puissance est correct pour des périodes ombre/jour.  

A présent, nous allons effectuer une seconde vérification qui consiste à calculer la puissance 

instantanée de façon théorique et de la comparer de nouveau au graphique mis en place par le 

logiciel STK. 

P=F*S*E 

E : efficacité du panneau solaire : 28% 

F : constante solaire : F = 1 360,8 ± 0,5 W/m². 

S : surface des panneaux solaires que nous allons déterminer à partir du graphique illustrant la 

surface du panneau solaire éclairé par le soleil.  
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Nous pouvons estimer la surface du panneau solaire éclairé par le soleil à : 

S=0,00426062 2m  

En remplaçant cette valeur dans la formule de la puissance théorique, nous obtenons une 

puissance instantanée P=1,5508W.  

On peut remarquer que cette valeur est en accord avec le graphique, La valeur n’est pas 

complètement exacte cela est surement du au procédé de calcul de puissance du logiciel STK. 

En effet STK va émettre plusieurs faisceaux solaires de manière aléatoire et le logiciel va 

détecter combien de faisceau ont été reçus par le panneau. Ce nombre varient en fonction du 

temps car il s’agit du procédé de Monte-Carlos. Par conséquent, on peut supposer que cette 

fluctuation est due à la variation de faisceaux détectés. Une autre hypothèse qui peut causer 

cette fluctuation est le fait que nous n’avons pas pris en compte la puissance générée par 

l’albédo de la Terre.  

A présent grâce à ce graphique de puissance, nous pouvons également calculer la puissance 

moyenne reçue par le panneau solaire, cette puissance va correspondre à la puissance 

emmagasinée par le satellite au niveau de ces batteries pour assurer son fonctionnement sur 

une  orbite.  

Cette puissance reçu moyenne se calcul de la manière suivante : 

reçumoyenP = (
max,rP * ONT )/(

offON TT  ) 

max,rP  : Puissance maximale reçu par le panneau solaire : 1,6W 

ONT  : Temps correspondant à une puissance reçu maximal : 54 minutes  
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offT  : Temps correspondant à une puissance nul : 32 minutes  

Après calcul, on obtient une puissance reçue moyenne d’environ 1W 

Comme dernière étude nous pouvons montrer que la puissance reçue par un panneau solaire 

est suffisante pour alimenter le récepteur/transmetteur du satellite qui consomme une 

puissance de 0.2W en mode receveur et 1.55 W en mode transmetteur.  

Nous avons lancé une simulation pendant 10 jours pour amasser le maximum de données pour 

la puissance. Par la suite  nous avons également relevé les données correspondantes aux 

instants où le satellite transmet des informations ou reçoit des commandes de la station. C’est 

donc à ce moment précis que le satellite consomme de la puissance. Grâce à ces données nous 

avons calculé la puissance consommée par le satellite ainsi que la différence entre la 

puissance reçue et la puissance consommée .Ce graphique montre la différence entre la 

puissance reçue et consommée en fonction du temps : 

 

 

 

Nous pouvons observer que la différence de puissance oscille entre deux valeurs 1.55W et -

1.5W. 1.5W correspond à la puissance stockée par les batteries. 0.2W valeur correspond à la 

-2 

-1,5 

-1 

-0,5 

0 

0,5 

1 

1,5 

2 

-5000 5000 15000 25000 35000 45000 55000 65000 75000 

P
u

is
sa

n
ce

[W
] 

Temps[s] 



18 
 

puissance consommée lorsque le satellite reçoit des commandes de la station sol, un signe 

négatif est présent car le satellite est en zone d’ombre donc il doit puiser dans ces batteries 

 Pour un temps t=41640s et t=47640s, la différence de puissance atteint une valeur de -1.55W. 

Cette valeur montre que le satellite transmets des informations à la station sol et comme 

précédemment le signe négatif montre que le satellite est dans une zone non éclairé et qu’il 

consomme de la puissance stocké dans les batteries.  

Nous pouvons conclure d’après ce graphique que le satellite stocke assez de puissance grâce à 

un seul panneau solaire pour pouvoir alimenter le receveur/transmetteur. Par manque de 

temps, nous avons pu réaliser une étude concernant l’ensemble ses composants du 

nanosatellite.   
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Conclusion 
 

 

Durant ce stage, au sein du laboratoire d'Astroparticule et de Cosmologie à l'université 

Diderot Paris 7, mon travail consistait à effectuer un prédimensionnement concernant le projet 

nanosatellite étudiant. 

Cette étape s'est déroulée grâce au logiciel STK. En effet, ce logiciel m’a permis de réaliser 

plusieurs scénarios d'orbite du satellite. Grâce à de nombreuses recherches d'informations 

pointues notamment sur les paramètres concernant le satellite, la station sol, le scénario s’est 

avéré en adéquation avec la réalité. Après avoir mis en pratique ce scénario, nous avons pu 

calculer certains paramètres spécifiques, comme par exemple la puissance instantanée reçue 

ainsi que le consommé par le satellite.  

Cette étude nous a permis de voir si le satellite alimente tout son système de navigation grâce 

en partie à la puissance emmagasinée par les panneaux solaires.  

Dans notre cas nous avons montré l’alimentation d'un unique élément qui est 

l'émetteur/transmetteur. 

Ce stage m'a été très bénéfique autant sur le plan personnel que professionnel. En effet, il m’a 

permis d'acquérir une autonomie de travail, de part les nombreuses recherches d’informations 

et de restitutions que le projet nécessitait. Ce travail a également aiguillé mon sens de 

l’analyse et de la réflexion à travers toutes les hypothèses et tests réalisés. 

Par ailleurs, le thème de la mission du stage m’a fait découvrir le monde de l'aérospatial et 

m’a fait prendre conscience de l'importance de ce domaine dans notre vie quotidienne.  

Ce qui m’a le plus touché est la passion que les enseignants chercheurs avaient pour ce  

projet. Il est vrai que cette volonté de réussir est venu renforcer l’esprit d’équipe et la 

détermination à faire aboutir le projet.  
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Fiche technique pour  l’utilisation du logiciel STK (Systems Tool 

Kit) 
Le symbole ‘->’ représente le cheminement aux niveaux des sous menus   

Dans un premier temps, nous allons montrer comment crée un scénario comportant 

uniquement  un satellite en orbite autour  de la Terre.  

Pour cela la première étape est d’ouvrir le logiciel STK et de se diriger vers l’onglet ‘ créer un 

scénario’. 

 

 

A présent après avoir effectué cette opération, une page ‘descriptive’ du scénario s’affichera, 

et il faudra nommer le scénario ainsi que déterminer la date de commencement et de fin. 

Après cette étape effectuée, cliquer sur ‘OK’.  
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 Par la suite une page ‘Insert STK Objets ‘ apparait avec une liste d’objets que l’on peut créer 

par exemple  un avion, un satellite etc. Dans notre cas, nous allons nous intéresser à la 

création d’un satellite ayant une orbite circulaire et ayant une altitude de 650 km. Pour ce faire 

les étapes sont les suivantes : 

Création du satellite : Insert STK Objetcs->New-> Satellite-> Orbit Wizard -> Insert 
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Après avoir sélectionné le satellite, une fenêtre de configuration apparait.  

 

 

Pour faire apparaitre le satellite ainsi que la place déterminée précédemment, il faudrait 

cliquer sur l’onglet ‘Show All Objets’. 
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Quand tous les paramètres ont été correctement remplis, il suffit de cliquer sur ‘Apply’, puis 

sur ‘Ok’  

 A présent nous pouvons visualiser sur la fenêtre ‘ 3D Graphics’, le satellite ainsi que sa 

trajectoire. Pour pouvoir lancer la simulation et observe r le satellite en déplacement, il faut 

cliquer su le symbole ‘Play’ présent au dessus de la fenêtre principale. 

 

Nous pouvons également modifier les paramètres du satellite  ou encore faire apparaitre 

certains vecteurs importants (vecteur vitesse, vecteur position…).  

Pour effectuer cette opération, il suffit de double clique sur l’icône satellite que vous avez 

créé et une page figurant les paramètres propre au satellite s’affichent. 
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Pour enregistrer ce scénario, il faut suivre les étapes suivantes : 

File->Save as. Puis indiquer le nom de votre scénario ainsi que l’emplacement. 

A présent, nous allons réaliser  un scenario correspondant au projet nano- satellite étudiant.  

Pour cela,  nous allons considérer les paramètres suivant  liés à notre satellite 

Type de satellite  Cubesat 3u  

Masse  4 kg  

Dimensions  10*10*30 

Orbite  Circulaire  

Type d’Antenne  lié au satellite  Dipôle  

Pointage  Terre  

 

Nous allons créer e satellite  grâce au logiciel sketchup un cubsat 3u, car ce modèle ne se 

trouve pas dans la base de données de STK. Pour cela, nous avons exporté du web un modèle 

de cubesat  1u  ayant des panneaux solaires.  Pour obtenir le satellite voulu, nous avons 

superposé trois cubesat : 
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Après avoir crée ce satellite sur le logiciel sketchup il faut à présent l’exporter sur logiciel 

STK, pour cela la première étape est d’enregistrer le fichier en format Collada : 

Ligne de commande : Fichier->exporter-> modèle 3D 
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Après avoir converti le dossier en collada, nous allons à présent l’ouvrir sur STK, pour cela 

nous devons préalablement crée un satellite quelconque comme précédemment et effectuer 

cette étape : 

Ligne de commande : double cliquer sur l’icône satellite->Modèle->Modèle file   

Sélectionner le dossier collada créé avec sketchup dans le bon répertoire puis cliquer sur la 

touche ‘Apply’.  

Pour visualiser le satellite que nous avons crée, il suffit  de cliquer droit sur l’icône satellite et 

appuyer sur l’option ‘Zomm to’ : 
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Pour visualiser le satellite que nous avons crée, il suffit  de cliquer droit sur l’icône satellite et 

appuyer sur l’option ‘Zomm to’ : 

 

Et nous obtenons le satellite ‘cubesat 3u’ : 
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A ce satellite, nous allons lui associer une antenne qui va permettre de transmettre les données 

prélevée à la station sol. Pour pouvoir avoir une antenne cohérente, nous avons pris comme 

référence  le projet ‘Swisscube’, qui nous permet de connaitre les paramètres exacts liés à 

l’antenne présente sur le satellite.  

Type  d’antenne  Dipôle  

Fréquence  145.8 Mhz 

Taille  51.4 cm  

Efficacité  100% 

Wave Lenght Ratio  0.249977 

azimut 0 deg  

Elévation  90 deg  

 

A  présent pour  compléter ce scénario, nous allons  ajouter certaines installations  associées à 

ce satellite, comme par exemple une antenne reliée au satellite qui va permettre la 

transmission de données vers la station sol. Une station sol pour recevoir  les informations 

transmis par le satellite.    

Création d’une station sol : Insert-> New-> Facility-> Insert Default  
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Après avoir insérer une station sol, nous devons  régler  la longitude ainsi que la latitude pour 

que celle-ci se trouve  sur Paris, pour cela il faut  régler  les paramètres propres de la station.  

 

Après avoir crée cette station, nous allons lui associer  une antenne pour transmettre des 

commandes au satellite, pour cela il faut réaliser les étapes suivantes. 

Insert-> New->Antenna->Insert Default   
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On double click sur l’icône ‘Antenna’  puis on l’associe a la station sol définie précédemment. 

 

 

 

L’antenne étant installée, nous allons régler ces paramètres (fréquence, polarisation...) pour 

que celle-ci transmettent les commandes au satellite. Pour cela, nous allons entrer les 
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caractéristiques  suivantes  que nous avons trouvés grâce au rapport de phase C du projet 

Swisscube.  

Type d’antenne  Dipôles  

Fréquence 145.8 Mhz 

Lieu  Paris, APC  

Efficacité  100% 

Wave Lenght Ratio 0.0483668 

azimut 0 deg 

Elévation 90 deg 

Taille 1 m 

 

Nous allons entrer ces caractéristiques, dans la page suivante : 

 

D e la même manière nous allons créer un récepteur associé  à cette station sol ayant les 

paramètres suivants :   
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Type  Simple  

Fréquence  437.5 Mhz  

G/T 17.26 dB/K 

Polarisation  Circulaire  

Modulation  BPSK  

Largeur de la bande passante du récepteur  0.01 Mhz  

 

 Ligne de commande : Insert-> New->Receiver-> Insert Default  
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Réglages des paramètres :  

 

Après avoir terminé  la configuration de la station sol, nous allons à présent associer une 

antenne au satellite qui permettra de recevoir les informations récoltés. Cette antenne possède 

des caractéristiques adaptées à la station sol.  Après avoir crée notre scénario, nous pouvons 

commencer à le manipuler, pour pouvoir calculer certains paramètres  comme par exemple, la 

puissance instantanée reçue par le soleil au niveau des panneaux solaire du satellite, si bien 

entendu  le satellite crée en possède, ou encore le moment où le satellite est détecté par la 

station sol. 

Pour effectuer cette opération, nous devons suivre les étapes suivantes : 
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Ligne de commande: Satellite->Solar Panel -> Compute-> Icône reset-> Type: power-> 

Graph-> Generate 

 

 

On obtient le graphique  de la puissance instantanée  en watt reçu par les panneaux provenant 

du soleil  en fonction du temps. 
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Pour analyser les valeurs de cette puissance, nous pouvons afficher les valeurs de cette 

puissance de cette manière :  

 

Les valeurs obtenues sont les suivantes : 

 

Nous pouvons également montrer  à quel instant  le satellite est détecté par la station sol :  
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Ligne de commande : Clique droit sur le satellite ->Coverage -> on sélectionne un objet 

(station sol, antenne...) ->Compute-> Graphs Coverage  
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Le graphique obtenu est le suivant : 

 

 

 

 


